Digital Color Management Guidebook

Color Management Techniques for the Canon Camera and Printer User

Color management is the single most effective way to ensure consistency in the digital workflow. This guidebook serves as a practical introduction to a color-managed digital photography workflow. Descriptions in the guidebook are based on usage of Adobe RGB as the color space. For even more advanced color management, also refer to Canon Digital Learning Center at www.usa.canon.com/dlc
Are Digital Workflows Difficult?

Film

Adjusting film images require a workflow

Checking the film

On a film camera, you would choose the film type to suit the situation, either daylight or indoor film, depending on the light source you were using. On a digital camera, you select the best Picture Style for the image and choose the correct white balance for the type of lighting.

Digital

Digital image adjustment is simple and

Checking the image

In the digital workflow, the display plays the same role as a light table. If you check your images on display and the colors look odd, the cause may very well be the display itself. This guidebook will look at how to select the correct display and how to calibrate it.

Color Chart

The color chart is a simulated reproduction made by printing halftone dots. As such, it should only be used as an approximate guide. If you need a more accurate color chart, third-party color charts for photographic use are available from camera stores or on the Internet.

Gray Card

The gray card was printed at a density of 18% using special ink. Use the gray card as a guide for setting the camera’s white balance or for correcting the white balance after an image is taken. Due to the thinness of the paper used to print this guidebook, the card can be affected by the background and by the light, so you should place a thick white or gray card or board behind the card when using it.
Although the tools for film and digital workflows are different, there are also many similarities. The digital darkroom consists of a computer and several hardware and software applications for selecting exposure and color settings similar to those in a traditional darkroom. This guidebook explains the equipment needed for a digital darkroom and studies actual color management techniques and workflow.

**in a darkroom.**

**flexible when using a computer.**

Compared with darkroom workflow for film, digital is very simple. With this guidebook, you will learn how to adjust images using a color chart. You can have your own digital darkroom using Digital Photo Professional Ver.3.0.

If your printer settings are incorrect, your prints will not come out as you intended. This guidebook will explain how to determine the correct settings using Easy PhotoPrint Pro.
Before you read this guidebook
This guidebook provides users of EOS DIGITAL cameras with an explanation of what color management is and how it works. Follow the procedures in this guidebook and make color management simple and easy.

The equipment you need to use this guidebook

An EOS DIGITAL camera equipped with Picture Style
* This guidebook uses an EOS 5D

A PIXMA printer
* This guidebook uses a PIXMA Pro9000

A computer with Digital Photo Professional Ver.3.0 and Easy-PhotoPrint installed
* This guidebook is based on use of a Windows computer with Digital Photo Professional Ver.3.0 and Easy-PhotoPrint Pro installed.

If you are using Digital Photo Professional Ver.2.2 or later on an Intel-based Macintosh, you may need to download the latest Easy-PhotoPrint Pro.
The color range differences that can be represented between in CMYK and RGB

With RGB, mixing the 3 colors in equal proportions produces white. With CMYK color, when the colors are mixed in equal proportions, the result is black. Because they use different principles, the ranges of colors that can be represented in CMYK and RGB are different.

Reproducing the Adobe RGB color space on a PIXMA printer

An image recorded in Adobe RGB uses a wider range of colors than CMYK (as shown in the figure on the left). But printing the image on a printer with the "CMYK + special color inks" option, such as the PIXMA Pro9000 gives color reproduction that more closely matches Adobe RGB. A printer that can faithfully reproduce what the camera captured at the moment the shutter opened is an indispensable tool in digital photography.

sRGB (standard RGB) is an international standard color space formulated by the International Electrotechnical Commission (IEC). You can minimize discrepancies between the input colors and output colors by using sRGB to adjust color on the camera, display and printer. For this reason, digital cameras, displays and printers generally use sRGB. However, the standard used in the Desktop publishing and photography industries is the Adobe RGB color space, which offers a wider range of colors and better color reproduction than sRGB.

Color Management Basics

Principles of Color Generation and Color Spaces

Devices such as digital cameras, displays and printers all generate colors differently. Digital cameras and displays use RGB color (the three primary colors in light). Printers and publications use CMYK (the primary colors in inks). The range of colors that can be produced or recorded by a device such as a camera, display or printer is called the color space. This chapter looks at the differences between the principles used to generate colors, the different devices used, and the different colors they generate.
Color Management Basics

What is Color Management?

Color management is not about making photos look better or getting the best color out of a particular device. Color management aligns an entire system of cameras, displays and printers so that the different color spaces (colors) produced are as close as possible. For example, factors such as the color of printing paper, the lighting in the room and lighting in the original photo can all affect the way colors appear.

Point 1 ICC profiles—Making device characteristics uniform

Digital devices such as displays and printers have their own characteristics and will not necessarily produce the same colors in the same way. ICC profiles provide a way of overcoming these differences in device characteristics by standardizing the colors produced by each device.

Point 2 White balance and color temperature differ according to light source

Depending on the light source used, white objects may appear to have a reddish or bluish cast. This is due to the different wavelengths of light produced by the light source, which is referred to as the “color temperature” of the light. Digital cameras have a white balance adjustment function that ensures that white colors always appear white regardless of the light source.

Point 3 Effects of color temperature on the subject

To minimize the impact of color temperature on the subject, it’s important to set the correct white balance for the light source when taking a picture.

Color temperatures for each light source

<table>
<thead>
<tr>
<th>Color temperature</th>
<th>Color</th>
<th>Light source</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000K</td>
<td>Strong red cast</td>
<td>Candle</td>
</tr>
<tr>
<td>3000K</td>
<td></td>
<td>Tungsten light</td>
</tr>
<tr>
<td>4000K</td>
<td></td>
<td>Fluorescent tube</td>
</tr>
<tr>
<td>5000K</td>
<td></td>
<td>Flash</td>
</tr>
<tr>
<td>6000K</td>
<td></td>
<td>Cloudy sky</td>
</tr>
<tr>
<td>7000K</td>
<td></td>
<td>Daylight (in shade)</td>
</tr>
<tr>
<td>8000K</td>
<td>Strong blue cast</td>
<td>Daylight</td>
</tr>
</tbody>
</table>

WB in daylight:
Shot using the Daylight setting

The image was taken with “Daylight” white balance setting in daylight conditions. The object appears in its natural white color.

With the “Daylight” setting and taken under fluorescent light. The color temperature of the light source gives the object a distinctly greenish cast.

When the light source changes, the color temperature causes the image to have a greenish cast.

When the image is taken with the white balance matched to the light source, the image shows the original colors.

WB under fluorescent tubes:
Shot using the Daylight setting

WB under fluorescent tubes:
Shot using the Fluorescent setting

The object again appears in its natural white color.
RAW images are unprocessed data

If you have a digital SLR camera, you will have come across the term "RAW image" many times. "RAW" means that the image data is in its original form and has not yet been processed in any way (by being compressed, for example).

RAW data gives you the control to create exactly the image you want

High quality
A RAW image consists of 12-bit data, while JPEG images contain only 8-bit data. Because RAW images are made up of the recorded output from the camera’s image sensors with no processing, they contain large amounts of data. You can then fine-tune that data from your computer to “post process” the image in any way you like.

Getting exactly what you want
Images shot in JPEG format are processed by a dedicated image-processing engine inside the camera based on the camera settings. But RAW image files are transferred directly to the computer without processing where they can then be edited using an image adjustment (or processing) application such as Digital Photo Professional (DPP) to obtain the desired outcome.

Features of RAW images in the workflow

For the best results, choose the display and printer carefully to complement your digital camera. To make your digital darkroom as effective as possible, choose devices that support Adobe RGB or sRGB. Here are some tips on how to choose the best equipment for your needs.
How to Choose the Right Equipment

Choosing a Printer and Display for Photography

To look at slides, photographers depend on a good light table and magnifying glass or loupe. Be as careful in choosing a display to look at digital files. The display is an absolutely vital tool for producing great images.

Point 1

Choosing the right display for color reproduction

To produce the best possible print from a digital file, it's key to have a display that will reproduce images just as the camera captured them. Nowadays, there are displays on the market that support Adobe RGB or sRGB. Some even come with integrated calibration tools.

Point 2

Calibrator tools are not just for professionals

Color management tools for the display, generally called "calibration tools," are now available at very affordable prices. Some displays even have their own color management functions.

Point 3

PIXMA printers complement EOS DIGITAL cameras

The PIXMA Pro9000 will reproduce Adobe RGB and sRGB images from the original file. Easy-PhotoPrint Pro software, which is included with the Pro9000 printer, provides a simple step-by-step approach to working with EOS DIGITAL cameras.

Note: See the next chapter for detailed setup instruction.
How to Choose the Right Equipment

Controlling Ambient Light for the Ideal Environment

Photographers may be very careful with their flash and white balance settings, but many of them are careless about the ambient light in the room where they adjust their images. For good color management, it’s important to pay attention to the ambient light as well as the device settings where you work. Ambient light can affect your display and your prints so that you end up with photos that have unnatural colors.

Step 1 Essentials in a professional studio

In photo studios used by professionals for image adjustment, ambient light is set to a color temperature of 5000K (K = Kelvin). By matching the ambient light to the light source used when the shot was taken and to the color temperature of the display, you can minimize the color distortion produced by the interior lighting when adjusting images on the computer.

Step 2 Use appropriate light sources

You can buy fluorescent tubes that are preset to around the 5000K color temperature that is known as “evaluative” light. By excluding external light and working under controlled lighting, you can adjust images more accurately.

Step 3 Position your monitor carefully

If you place the monitor close to a window, it will be affected by the daylight. The color temperature of daylight varies depending on the weather and the time of day. This can result in unnatural, or inconsistent color even with the most painstaking image adjustment.

Step 4 Take care with wall color and curtains as well

In addition to the light from windows, reflected light bouncing off walls or curtains near the monitor can have surprisingly large impact. This doesn’t just apply to the display. You also have to be aware of the effects of ambient and reflected light in locations where you check your prints.
Setting up a viewing environment with a display hood

A display hood is an effective way of reducing exterior light sources on a display. Rather than purchasing a commercially available display hood, you can make your own hood out of cardboard and Indian ink or poster paint.

Building your own display hood

A hood can be made out of cardboard or other thick, non-reflective material. The inside of the hood should be matte black to absorb light.

Device Settings for Color Management

In color management, it is vital to maintain consistent device characteristics from the digital camera right through to the printer. Canon digital cameras and printers can quickly and easily be set up for color management. In this chapter, you will set up the camera and then use the color chart at the back of this guidebook to set and check your settings in Digital Photo Professional (DPP) and Easy-PhotoPrint Pro (EPP Pro). Then you will adjust your display settings.
To set up your digital camera for optimal color calibration, complete the following steps:

**Device Settings for Color Management**

**Camera Settings and Color Chart Photography**

**Setup 1** Set the image type

In [Quality], select [RAW].

**Setup 2** Set the color space

Select [Faithful] in [Picture Style].

**Setup 3** Photograph the color chart

Be careful not to bend or tilt the color chart. Photograph the chart from directly in front with no exposure compensation.

Note: It is best to shoot in a location where there are no reflections from furnishings or wall coverings. Try to choose a location where there will be no color cast from surrounding light.
Device Settings for Color Management

Display Settings

The best way to calibrate a display is with a color calibration tool. Until quite recently, commercially available color management tools for displays were very expensive. These days, a number of calibration tools are available at very affordable prices and are recommended accessories for serious digital photographers. Some of the manufacturers of these devices are xrite/GretagMacbeth™, Monaco Systems™ and Pantone®. The calibration tool will help to adjust the display and create a suitable monitor profile.

Setup 1 Prepare the system for calibration

Warm up the monitor for 1 hour before beginning the calibration. Disable any power management functions such as screensavers or sleep functions and turn off any other display management functions.

Setup 2 Begin the calibration

Following the procedures in the instructions, connect the calibrator and run the software. If you follow the instructions, it is quite simple to calibrate your display and generate a monitor profile.

Setup 3 Check whether the monitor profile has been applied

On a PC: Open [Control Panel], and double-click [Display], then click the [Settings] tab sheet and click the [Advanced] button. Then click the [Color Management] tab sheet to check whether the profile you have just created is being used. On a Mac: Go to the Apple menu and select [System Preferences], Click on [Displays], Click on [Color] and select the [Monitor profile] you have just created.
Device Settings for Color Management

Digital Photo Professional Ver.3.0
Settings and Test Image Preparation

The next step is to specify the settings in Digital Photo Professional Ver.3.0. By making sure that the color calibration has been applied and is working in cooperation with your imaging programs color space, you’re on the way to achieving correct color.

Note: For detailed information on Easy-PhotoPrint Pro specifications and system requirements, refer to Canon Digital Learning Center at www.usa.canon.com/dlc

---

**Step 1** Set the work color space

First, select the work color space for DPP. Go to [Tools], select [Preferences] and open the [Color Management] tab sheet. Then select [Adobe RGB].

**Step 2** Choose the display settings

In [For display] in [Color matching settings], tick the [Monitor profile] checkbox and click [Browse]. Then select the monitor profile you’ve created (on pg. 20). If there is no monitor profile, select [sRGB].

**Step 3** Collaborate with EPP Pro

Choose the matching method to be used with Easy-PhotoPrint Pro. Here, select [Relative Colorimetric].

**Step 4** Open the test image

From DPP, open the test image (the color chart photo on pg. 18).

Note: In the next page, you will check your system with these color management settings applied.
Device Settings for Color Management

Easy-PhotoPrint Pro
Settings and Color Chart Checking

This chapter covers the steps from setting up Easy-PhotoPrint Pro through printing out the test image. Easy-PhotoPrint Pro is installed from the CD-ROM that was bundled with your PIXMA Pro9000 printer. At this point, using color management is easy—all you have to do is select the correct check boxes.

Note: Refer to the web site for detailed information on Easy-PhotoPrint Pro specifications and system requirements.

---

1. **Print the test image**
   
   Open the test image in DPP and select [Print with Easy-PhotoPrint Pro] from [Plug-in printing] in the [File] menu. Easy-PhotoPrint Pro then starts up.

2. **Set the print quality**
   
   After selecting the paper size and media type to use, click the [Set] button, and select [Custom] for Print Quality.

3. **Set the settings dialog**
   
   Set by moving the slider for [High] toward [Fine].

4. **Set the color mode**
   

   Note: Now compare your photo with the actual simple color chart to see whether the colors were managed correctly using Adobe RGB.
Compare the print, the display and the included color chart

Now use the color chart at the back of this guidebook to see whether these color management settings have worked with your system. Compare the photographed color chart and the printed color chart.

Hold the included color chart and the printed color chart up side by side in front of the display

Check whether the colors on the displayed, printed, and included color chart match closely. If only the display colors are different, try calibrating your display again.

Practical Techniques Using Color Chart for Image Adjustment

Using a color chart when you take pictures can make a huge difference to how well the colors of your subject are reproduced. In this chapter, you’ll look briefly at the steps from setting the white balance manually to adjusting images using a color chart.
Practical Techniques Using Color Chart for Image Adjustment

Set the Camera’s White Balance Manually by Using a Gray Card

Capturing white objects so that they appear white regardless of the light source is fundamental to accurate color rendition. With a RAW image, it’s easy to select the correct color temperature even after the image is taken. The Auto White Balance feature on EOS DIGITAL cameras will in most cases ensure that your images have the correct white balance, but if not, this chapter tells you how to set white balance manually. When using the Custom White Balance setting, it is important to readjust the setting whenever shooting conditions such as the light source or shooting angle change.

**Step 1** Photograph the gray card

Set up the gray card so that there are no shadows visible, then hold the camera directly in front of the gray card, and focus and compose the shot manually so that the entire card is seen in the viewfinder. Then take the picture.

**Step 2** Set the white balance

Press the <MENU> button on the back of the camera and choose [Custom WB]. Then press the <SET> button.

**Step 3** Select the photograph of the gray card

Turn the dial on the back of the camera to select the image of the gray card that you just shot and press the <SET> button.

**Step 4** Exit the setting procedure

Exit the menu, and set the camera’s Custom White Balance.

Note: Refer to your camera’s Instruction Manual for how to set the camera’s white balance.
Practical Techniques Using Color Chart for Image Adjustment

Using Color Chart to Restore Colors

At one time or another, every photographer has wished for the ability to accurately reproduce the colors of a subject at the moment the shot was taken. A color chart makes it simple. Use the steps here to shoot a subject together with a color chart and restore the colors in your digital darkroom.

Step 1
Photograph the color chart
Take the shot with the color chart alongside your subject.

Step 2
Take the actual picture
Remove the color chart and shoot the actual picture using exactly the same exposure, shutter speed and shooting angle as the shot with the color chart.

Step 3
Finish shooting
Now you are ready to restore the colors in your digital darkroom. Comparing the color chart shown on the display with the actual color chart makes it easy to adjust the image.

On the next page, try adjusting the image using the color chart.
Practical Techniques Using Color Chart for Image Adjustment

Fine Tune Images by Using a Color Chart and DPP

When a image is taken in RAW mode, adjustments can be made with minimal image quality loss. Learn how to adjust color in a RAW image.

**Step 1**  
Set the white balance

Open the color chart image you shot during DPP camera setup and click the [ ] button in [White balance adjustment] in the [RAW] tab sheet. Then click in a gray section in the on-screen color chart.

Note: These settings are only available with RAW images.

**Step 2**  
Adjust the brightness

In [Brightness adjustment], adjust the settings until the white, gray and black sections in the on-screen color chart match the actual color chart.

**Step 3**  
Adjust the color tone and color saturation

In [Color tone] and [Color saturation] in the [RAW] tab sheet, adjust the settings so that the image colors match the colors in the actual color chart.

**Step 4**  
Apply the adjustment recipe

Select [Copy recipe to clipboard] in the [Edit] menu to copy your settings as a “recipe”. Then open your actual shot and select [Paste recipe to selected image] in the [Edit] menu to apply the copied recipe settings to your actual image so that your subject’s colors are reproduced accurately.
System Requirement

Digital Photo Professional Version 3.0

Software System Requirements | Windows®
--- | ---
**OS** | Windows Vista™*1  
Windows XP Professional/Home Edition*2  
Windows 2000 Professional*3
**Computer** | PC with one of the above OS preinstalled  
* Upgraded machines not supported
**CPU** | Windows Vista 1.3GHz Pentium or higher  
Windows XP, 2000 750MHz Pentium or higher
**RAM** | Windows Vista Minimum 1GB  
Windows XP, 2000 Minimum 512MB
**Display** | Screen resolution: 1024 × 768 pixels or more  
Color quality: Medium (16 bit) or more

*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition  
*2 Compatible with Service Pack 2  
*3 Compatible with Service Pack 4

Software System Requirements | Macintosh
--- | ---
**OS** | Mac OS X 10.3 to 10.4
**Computer** | Macintosh with one of the above OS installed
**CPU** | Minimum 400MHz, PowerPC G3, G4, G5 or Intel processor
**RAM** | Minimum 512MB
**Display** | Resolution: 1024 × 768 or more  
Colors: Thousands or more

† This software program is not compatible with UFS (UNIX File System) formatted disks.  
† DPP also runs comfortably on Intel-based Macintosh since it is a Universal application.

Supported Image Types

<table>
<thead>
<tr>
<th>Image type/Camera used</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW images</td>
<td>EOS-1D Mark III, EOS-1D Mark II, EOS-1Ds Mark II, EOS-1D Mark II, EOS 5D, EOS 30D, EOS 20D/20Da, EOS DIGITAL REBEL XT, EOS DIGITAL REBEL XT</td>
</tr>
<tr>
<td></td>
<td>EOS-1Ds, EOS-1D</td>
</tr>
<tr>
<td></td>
<td>EOS 10D, EOS DIGITAL REBEL, EOS D60, EOS D30, PowerShot Pro1†</td>
</tr>
<tr>
<td>JPEG images</td>
<td>Exif 2.2 or 2.21-compatible JPEG images</td>
</tr>
<tr>
<td>TIFF images</td>
<td>Exif-compatible TIFF images</td>
</tr>
</tbody>
</table>

† You cannot edit with the DPP RAW image adjustment function.

For details of Easy-PhotoPrint Pro specifications and system requirements, refer to Canon Digital Learning Center at [www.usa.canon.com/dlc](http://www.usa.canon.com/dlc)